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1.0 Introduction  

The Technological University of the Shannon: Midlands Midwest (hereafter referred to 

as TUS or the Technological University) is a regionally focused higher education 

institution with a national and international outlook. Among its shared values includes 

a commitment to equality, diversity and inclusion. TUS values and promotes 

inclusiveness, equity of opportunity and respect for all students and staff. The 

Technological University aims to provide opportunities for all students and staff to 

thrive in higher education and in the wider community through the promotion of positive 

identities and abilities, the celebration of diversity and difference, and the provision of 

an inclusive, participative culture and environment.  

 

In its application for designation as a Technological University, TUS identified Equity 

and Inclusiveness as a shared value “we will value and promote inclusiveness, equity 

of opportunity and respect for all students and staff, especially those from under-

represented groups, such as ethnic minorities and persons with disabilities.” [1] TUS 

commits to “provide leadership in promoting and advancing equality, diversity and 

inclusivity” and is committed to ensuring “that education and service planning and 

provision embrace the needs of all students  and staff and are delivered in an 

environment that is inclusive and accessible to all”. [1] 

 

The Technological Universities Act 2018[2] requires “the attainment of gender balance 

and equality of opportunity to be promoted among the students and staff of the 

technological university”. Therefore, the Technological University has in its 

foundational attributes[1] specified that it will: 

- “deliver a supportive people-orientated learning environment and student-

centred educational experience where students and staff can benefit from 

opportunities for development, with a shared set of common aims and clear 

lines of communication”, and that it will; 

- “take an integrated, collaborative approach that listens to the voices of all 

stakeholders and that upholds principles of equality, diversity, and inclusion”. 

 

The Technological University is increasingly diverse and it is vital that all members of 

its community and external stakeholders are supported through accessible 

documentation that supports equality diversity and inclusion. This is consistent with 

the objectives outlined in its application for designation to: 

- build an environment where all members of the TU are respected equally and 

where everybody’s cultural identity and sense of belonging are nurtured. 
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- ensure that education and service planning and provision embrace the needs 

of all students and staff and are delivered in an environment that is inclusive 

and accessible to all.[1] 

The Technological University is cognisant of its obligations under The Equal Status 

Acts 2000-2015[3], as amended which prohibits discrimination on the provision of 

goods and services, accommodation and education. The Disability Act 2005[4] 

identifies the requirement to provide information in an accessible format. In developing 

documentation in accordance with the Guidelines set out in this Policy, the 

Technological University will be mindful of its statutory obligations under these Acts. 

 

This guide is designed to align to national and international effective practice that 

supports Equality, Diversity and Inclusion objectives in Technological University 

Communications, particularly in its written documentation. This is consistent with the 

EU directive requiring public bodies to ensure their content is accessible to everyone.[5]  

It is also in line with the Technological Higher Education Quality Framework (THEQF)[6] 

principle of quality assurance and enhancement, “consistency with policy and 

international effective practice”, which has been adopted by TUS.  

 

2.0 Purpose of the Guide 

This Guide is produced in the context of TUS’s commitment to equality, diversity and 

inclusion and our commitments within our institutional wide Athena Swan Gender 

Equality Action Plan. It provides a set of guidelines to ensure that a consistent 

approach is adopted across the TUS in the development of formal University 

Documentation that is cognisant of the diversity of all readers.  

The Equal Status Acts outline the grounds in which individuals can be/or feel 

discriminated against and these include disability and gender. It is therefore imperative 

that our formal University documentation is cognisant of the obligations under the 

Equal status Act and is fully inclusive 

Part A of this guide, Incorporating Accessibility Features into Documentation, provides 

recommendations for developing documentation that incorporates clear layout and 

structure and utilises accessibility features that support the effective use of the 

resulting documentation by all readers. Part B, Making Gender Neutral Documents 

and Communications, outlines effective practice and guidance in making gender 

neutral communications and contains a listing of suggested neutral word/phrase.  

Depending on the type of documentation that is being written, it is acknowledged that 

there may be a number of factors to be considered and a need to balance different 
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parameters for a variety of formal Technological University documentation.  

3.0 Scope of the Guide  

This Guide shall be a constituent document of the TUS Quality Assurance Handbook. 

It shall serve as an approved reference point and guidance for Technological 

University Staff and assist in producing Technological University documentation, 

including Policies and Reports inter alia, that takes account of accessibility principles 

and supports inclusivity. The constituent documents of the TUS Quality Assurance 

Handbook shall be formatted in a manner that takes account of best practices relating 

to the accessibility principles outlined in this document and utilise gender neutral 

terminology. This document is not intended as a Guide for UDL principles in the 

context of the design of learning resources.  

 

Part A of this Guide outlines how accessibility features may be utilised to generate 

documentation that allows for content to be presented in an accessible manner. These 

guidelines focus on how formal Technological University documentation such as 

Policies and Reports can be written and presented in a professional and consistent 

format. 

 

The guide is designed to further inform staff when writing Technological University 

documentation on the recommended layout, structure, and style to ensure a consistent 

approach across the University. The guide covers the following accessibility features: 

• Headings 

• Typeface and Font   

• Bullet points  

• Colour contrast 

• Alternative text 

• Table of Contents   

• Hyperlinks  

• Forms 

• Visual displays diagrams etc 

• Accessibility Checker 

• Converting a document into an Audio file[6]  

 

A summary of recommended approaches for the accessibility features is provided. 

These recommendations are based on Universal Design for Learning (UDL) and 

Technical Writing Guidelines. However, it should be noted that there are a variety of 

factors that may need to be taken into consideration and balanced when adopting a 

particular approach. It may also be necessary to be cognisant of the type of 
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documentation that is being produced and consider other factors relating to this (e.g. 

marketing documents, lecturers notes, formal policies will invariably need to look 

different (for example, while UDL Guidelines recommend that left aligned text is easier 

to read, Technical Writing Guidelines indicate that the standard format for 

Professional/Formal documentation is fully Justified[7]).  

 

Therefore, this Guide does not outline one set standard for all documentation and 

recognises that a variety of factors may need to be balanced when choosing a 

document format.  The type of document being produced may determine which format 

is selected once all factors are considered. 

 

Part B of this Guide outlines how Gender Neutral Communication can be supported. 

This recognises the importance of respecting diversity, both individuals and groups, 

and how to ensure that this is reflected within Technological University documentation.   

 

 

4.0 Part A: Incorporating Accessibility Features into Documentation  

This section looks at some of the general design and layout features in MS Word that 

can be selected to improve the accessibility of documentation. These include the font 

style, use of colours and page layout which can be used to assist readers to go through 

resulting documentation, find information easily and understand the document more 

readily. In addition to the general features of Word, there are a number of specific 

useful accessibility features such as text to speech, alternative text (alt text) and the 

accessibility checker which can assist in enhancing the accessibility of the 

documentation. 

 

Effective practice based on national guidelines from organisations such as AHEAD  

and AHEAD[8], the National Adult Literacy Agency NALA[9] as well as EU Guidelines[5] 

and international recommendations including the Center for Applied Special 

Technology CAST[10] are profiled in  Section 4.1 to 4.12.   

 

A summary of recommendations to be integrated into the development of University 

documentation is provided in Section 4.13. 

 

4.1 Using the Accessibility Checker 

The Accessibility Checker is a feature within Microsoft Office that checks to see how 

accessible a document is and how easy the document is for people with disabilities to 

open, read and edit. When the Checker runs it will highlight any issues within the 

https://www.ahead.ie/
https://www.nala.ie/
https://www.cast.org/
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document and provide suggestions on how to resolve them. This feature is a useful 

one to have open from the beginning when writing a document or to look at when a 

document is being reviewed. 

 

The Accessibility Checker will review the document and highlight issues and warning 

related to poor accessibility. Some of the areas identified in the Accessibility Checker 

include: 

• Any text where there is poor contrast between the background colour and the 

text.  

• If images or charts are not correctly described or if alternative text is missing 

from an image.  

• Review any tables that have been added to a document and also identify if the 

order and flow of the table is in sequence. 

 

For further details on how to open and use the Accessibility Checker in Microsoft Word 

see Appendix 2. Please note that the Accessibility Checker is available in a range of 

Microsoft Office Applications such as One Note and PowerPoint inter alia.  

 

4.2 Using Headings Appropriately 

Appropriate use of Headings makes documentation easier to read and helps provide 

a clear structure. Microsoft Word provides a variety of heading styles that can be used 

to automatically generate a Table of Contents.  

 

Using separate Headings and sub-headings will automatically separate content and 

allow readers to find relevant information with greater ease. It will also make 

information easier to scan and will assist anyone using assistive technologies like the 

screen reader.  

• Headings should be different in colour or size and spacing to normal text so 

they are easily identifiable as headings.  

• Use adequate line spacing around a Heading to help distinguish it from normal 

text and to ensure it is not clutter on the page. 

• Use the Headings in the Styles section of the MS Word Ribbon to ensure that 

each Heading style is the same throughout the document. 

 

Figure 1. MS Word Ribbon - Heading Styles 
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4.3 Typeface and Font   

The typeface and font refer to the style of lettering that is used in the document. The 

typeface and font selected in a document will impact on the readability of the document 

and readers will likely lose interest or get frustrated if the words are difficult to 

recognise. 

 

4.3.1 Typeface 

Typeface refers to a collection of related fonts and they are classified by their 

letterforms. Typeface classifications include, Serif, Sans Serif, Script, Monospace 

Display and Handwritten inter alia. 

• San Serif Typeface like Arial, Tahoma and Verdana are considered 

more legible to read on-screen and most suitable for documentation 

being read on a computer. 

• In contrast, other fonts like Bodoni MT poster, chiller and Forte are quite difficult to 

read and may cause difficulty for certain readers. 

 

4.3.2 Font 

Font refers to the style and variation that can be applied to a Typeface. Examples of 

changing a Font include changing the weighting, making the font bold or putting in 

italics.  

 

For example the Typeface Verdana is used below but a different font is used.  

• Verdana Regular font 

• Verdana Italic font  

• Verdana Bold font  

• Verdana Pro Light 

• Verdana Semi-bold 

 

A document could have one main Typeface throughout the document such as Arial 

with three fonts used to highlight different sections or content within the document 

such as: 

• Arial Regular for standard text 

• Arial Bold for Headings 

• Arial Italics for quotes 

 

4.4 Line Spacing 
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Line spacing is the amount of space between each line within a paragraph. Too much 

can make text disjointed and difficult to read and too little can decrease readability. It 

is important to ensure that same line spacing is applied throughout the entire 

document to make it easier to read.  

 

• The recommended amount of spacing between lines is 1.2 to 1.5.  

 

4.5 Utilising Bullet points 

Bullet points are an effective way of clarifying and presenting data. They can help to 

focus the reader’s attention and provide a visual break from reading longer sections 

of text. They can be used to highlight the main or key points in a document. 

• Avoid long lists of bullet points and sub divide the points if necessary 

• Avoid italics and underline for emphasis 

• Avoid all CAPS because it may convey the wrong tone and make the text more 

difficult to read. We recognise the word by the shape. This is called Sight 

Vocabulary and it may slow down the reading process.  

• Use Tab button instead of repeatedly using the spacebar. This creates a better 

experience for students using the “Read Aloud” feature (Read Aloud is a built-

in feature in MS Word that will read aloud any text in a document). 

 

4.6 Colour 

When using colours in documents, ensure that there is strong contrast between the 

text and the background. Poor contrast affects the readers ability to perceive and 

interpret the content.  For text to be legible or for data in diagrams, tables and charts 

to be distinguishable there should be a strong colour contrast. The following are 

examples of good and poor colour contrast: 

- Good contrast between text and background. 

- Poor contrast between text and background.  

Poor contrast can make text very difficult to read. It is advisable to use dark contrasting 

colours like blue, red, green and purple.[7] Certain sight conditions enhance the 

negative effects for bad contrasts and make text even more difficult to read. 

 

4.7 Alternative Text (Alt Text) 

Alternative Text, or Alt Text, provides a description of an image. This text can be used 

to provide an alternative description of the image for those unable to view the image. 

A screen reader can be used to process and read out the description provided.   

 

Screen readers are used to read out text written in a document. However, if there is 
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an image, graph or a bar chart then the screen reader cannot process this, and the 

reader will miss out on key information if the Alt Text for the image has not been added. 

• To add Alt Text, right-click image and click “Edit Alt Text” and then enter image 

description.  

• Enter in a description of the image that can then be read out by the Read Aloud 

feature in Word.  

 

Figure 2 Illustration of the Alt Text Function 

                                  

4.8 Table of Contents  

A Table of Contents is key to helping people review the contents of a document at a 

high level, it provides an overview of the structure to the document and help readers 

find relevant information quickly and easily. If the Table of Contents feature in MS 

Word is used it will automatically update changes that are made to sections and 

heading within the document. The Table of Contents makes it much easier for students 

who have learning difficulties like dyslexia to read and process the information within 

a document. 

 

Figure 3 Image of the Table of Contents Ribbon 

 

• Any Sections and Headings that are added to a document should be formatted 

using the Styles section outlined in Section 4.1 so they will be recognised and 

included in the Table of Contents. 

• It will automatically edit the Table of Contents based on the Headings that have 

been added to the document.  

• Numbering on Headings and Sections will automatically update if sections are 
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manually moved while editing the document. 

 

4.9 Generating Hyperlinks 

When adding hyperlinks into documentation it is important to distinguish the hyperlink 

from normal regular text so the reader is aware that a link has been added. The Read 

Aloud feature within MS Word has a shortcut which will bring up a list of the links in a 

document. Links need to be unique and descriptive so that they make sense when 

they are assessed as a list, without the surrounding text for context.  

• Avoid displaying the full URL address on the document page, instead rename 

the link so it is easier for the reader to see what website the link will open.  

• Try and use descriptive and relevant text instead of “click here” or similar 

phrases. 

• The standard format for hyperlinks is underlined text in a blue colour, e.g. TUS 

Midlands Midwest main website would appear as follows:  Home - TUS 

 

4.10 Effectively Displaying Data in Tables, Charts and Diagrams 

Data displays refers to data that is presented in a table, chart or diagram and allows 

for information to be presented in ways that text alone cannot. Diagrams can be used 

to visually display information, they “use visual means to show qualitative differences 

and relationship” [8].  The number and type of charts, diagrams, and tables that can be 

used to represent data will vary for each document.  

The following recommendations will support readers to interpret and follow data being 

displayed: 

• The best way to make sure that charts and diagrams are readable to visually 

impaired learner is to use detailed Alt Text;  

• When adding Alt Text accurately and comprehensively describe every section 

and connection points of the chart or diagrams;  

• When using line charts, it is important to remember any readers who may be 

colour blind. A slight change in the line style can instantly make the chart more 

accessible e.g. the use of dotted lines instead of different colours; 

• Ensure when using tables and charts that there is good colour contrast between 

the text and the background. 

 

Further details on design recommendations for diagrams and charts are available from 

the following link: Accessibility at Penn State | Charts & Accessibility (psu.edu) 

 

 

https://tus.ie/
https://accessibility.psu.edu/images/charts/
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4.11 Forms 

MS Word Forms 

There are many Technological University Forms for both staff and students that are 

developed either as standalone forms or may be included as part of the policy 

document.  

 

When creating a Form, the Developer Tab in Microsoft Word allows for tick boxes, 

drop down menus and lists to be created. These are easier for users to complete and 

more accurate when gathering data. The Developer Tab can be added to the Ribbon 

in Word. The steps for adding and using this feature are available in Appendix 2. 

Online MS Forms  

 

For online forms, as part of the MS Office 365 suite, all staff have access to MS Forms. 

This online form allows a link to be sent and shared out to users to gather and collate 

data. It is recommended to minimise the number of open-ended questions where 

possible. A generic TUS Template for Online Forms has been created and it can be 

modified as required. This can be accessed at: TUS Online Forms Template.  

 

4.12 Converting a Document into an Audio File  

Information can be processed in multiple different ways and it is important for writers 

to provide a variety of formats of the information. Producing content in a variety of 

formats and resources will make content/information more accessible. Many people 

find that processing information is made easier by listening to it and it is possible to 

convert a word document into an audio file.  

 

For support on converting a word document to an audio file click on the following guide: 

Convert word documents into audio files 

 

 

4.13 Summary and Overall Recommendations (Accessibility Table) 

A summary that may be used as a quick reference guide when writing University 

Documentation has been collated in Table 1.  

 

  

https://forms.office.com/Pages/ShareFormPage.aspx?id=ma6_YTgGrECcOkZcQFn5brUqiyQvBMRBjsbYUmiTB_xUNzE5VjlKNFBaTVlIWVVUQUpUMlRYTjg4Ri4u&sharetoken=rLajrmiCtcMX2JxSCaL7
https://ally.ac/covid19/
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Table 1. Suggested Guidelines for Writing Documents* 

Items Description Benefit 

Typeface San Serif such Verdana and 

Arial & Tahoma  

Easier text to read than Serif 

text such as Times New Roman 

Font Keep to the regular font. 

Bold should be reserved for 

Headings or when 

emphasising key words. 

Italics kept to a minimum 

such as quotes. 

Students with visual 

impairments can see text easier 

in the regular font. 

Easier reading improves 

engagement 

Font 

 

Powerpoint presentation, 

size - 24 

Word documents – size 12 

Improves readability for students 

with Dyslexia, low visibility 

students 

Colours 

 

Use of contrasting colours - 

Colours that may not be 

visible to colourblind students 

would include light blue and 

yellow 

Increases engagement and 

easily highlights key information  

Line Spacing 

 

Minimum spacing should be 

between 1.2 and 1.5 

Makes text easier to read  

Section Headings 

 

Clearly identify headings and 

section content  

Allows readers to find relevant 

content easier. 

Page Numbering 

 

Apply number in clear black 

at bottom of page in the 

centre of the page. Avoid the 

use of Roman numerals. 

Page number helps readers 

keep track of the document. 

Table of Contents 

 

Allows for section headings 

to be easily linked to and 

sections and page numbers 

automatically updated. 

Allows readers to view content 

easily and navigate through a 

document 

Graphs  

 

Use graphs with clear data 

Avoid cluttered graphs/charts  

Allows readers to interpret the 

data clearly. 

Images and Including alt text Visually impaired readers can 
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Logos 

 

use read aloud function. 

Hyperlinks Links are blue and 

underlined 

Provides a consistent and 

standardised format for 

hyperlinks 

References – 

style 

Use Harvard Style  Aligns to the Universities 

recommended referencing style 

Words per 

sentence  

Try to keep sentences 

between 15-20 words. 

Increase accuracy, relevance & 

understanding  

Text Alignment Justified for the text within 

the main body of the 

document 

Provides equal spacing on the 

left and right sides of the text 

block which gives the text a 

more formal appearance. 

 

* Based on guidelines from the National Adult Literacy Agency  NALA[9] and AHEAD[8] as well as 

EU and international recommendations including the Center for Applied Special Technology 

CAST[10]. 

Although there are many variances in the type of information that will be included in 

the different types of documentation being produced such as policies, reports, 

application forms, inter alia, the aim is that these guidelines will support consistency 

in the layout, structure and format for how Technological University documentation is 

developed and accessed. 

 

A template file has been created which has been formatted based on the guidelines 

below and is available to download and use from this link: TUS Document Template.  

  

https://www.nala.ie/
https://www.ahead.ie/
https://www.cast.org/
https://studentlit-my.sharepoint.com/:w:/g/personal/patrick_fitzgerald_lit_ie/EdRyoSAVXzJArNVCh4SS0HMBKXCTgHsmE9hO9imPwxmZDg?e=WaxLT3
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5.0 Part B : Making Gender Neutral Documents and Communications  

This section of the guide is produced in the context of TUS’s commitment to equality, 

diversity and inclusion with particular emphasis on guiding and supporting gender 

neutral communication. In line with Athena Swan Gender Equality Action Plan 

commitments, this section offers rationale for and examples of gender neutral terms 

for use in TUS official documentation as well as for staff who are seeking additional 

guidance and support in inclusive language.  

 

The Technological Universities Act references promoting the attainment of gender 

balance and equality of opportunity among students and staff of the Technological 

University. This Guide supports this objective. It is further noted that the Act references 

that some Statutory Bodies, such as Governing Body and Academic Council make 

references to minimum numbers of women and men in their composition and the 

associated documentation will reflect this. This section is therefore a guide to gender 

neutral communication, and statutory reporting obligations, such as those outlined in 

the Technological Universities Act, may supersede this guide. 

 

Moving beyond gendered terms can make a document more reflective of the diversity 

of families and relationships in Ireland - for example, a woman’s spouse is not 

necessarily male, and a single parent is not necessarily female. Gender-neutral 

language also allows for open interpretation of social roles – for example, the term “fire 

fighter” allows the reader to imagine someone of any gender, unlike the term “fireman”.  

 

Producing documents that are gender-neutral or updating existing documents to make 

them gender-neutral, demonstrates our acknowledgement and inclusion of 

transgender members of our community (students, staff or visitors). Many people do 

not identify as either male or female and references to “he”, “she” or “he/she” are 

therefore often not adequate to describe all the people to whom a document applies1. 

Finally, it is not necessary to include gender distinctions in most documents (many 

languages get by without them) and removing them can make documents more 

concise.  

A list of suggested neutral words/phrases is provided in Table 2. This contains 

suggestions that may assist you in making gender-neutral documents or other 

communications. Gender-neutral wording decisions may be very simple, and a neutral 

term can just be slotted into the place of a gendered term. In more complex cases, it 

 
1 This doesn’t mean that all transgender people like to be referred to as “they” – but “they” 
covers all genders in a document which will be read by a wide variety of people 
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can help to rethink the order of the sentence, to search alternative terms, or to consider 

whether the phrase / sentence is necessary at all. 

Table 2. Suggested neutral word/phrase 

Gendered word/phrase Suggested neutral word/phrase 

“He”, “She” or “He / She” They 

“His”, “Her” or “His / Her” Their 

“Him”, “Her” or “Him / Her” Them 

“Mr”, “Ms” or “Mr / Ms” You should avoid using these gendered titles unless 

they are necessary. If they are necessary, such as on 

some forms, it is good practice to offer “Mx” as an 

option as well as “Mr” and “Ms”, “Mx” is a title that 

can be used by a person of non-binary gender or by 

anybody who prefers not to disclose their gender. 

“Father” / “Mother” Parent (similarly, “Grandparent”) 

“Husband” / “Wife” Spouse 

“Boyfriend” / “Girlfriend” Partner 

“Son” / “Daughter” Child 

“Man” / “Woman” Person (or occasionally “human” can be more 

appropriate, e.g. “humankind”) 

“Chairman” / 

“Chairwoman” 

Chairperson (or “Chair”) 

“Dear Sir / Madam” This could be replaced with “To Whom it May 

Concern”, “Dear Colleague”, “Dear Student”.  

“Ladies and Gentlemen” “Honoured Guests”, “Esteemed Colleagues”, inter 

alia. 

Gendered job titles e.g. 

“Barman” / “Barmaid” 

Look up neutral alternatives e.g. “Bartender” 

“Male” or “Female” as 

adjective 

Don’t use if not necessary to do so: for example, the 

adjective in phrases like “male nurse” or “female 

Professor” is not usually necessary. However, you 

might use these terms where gender is specifically 

relevant, for example in a report on the number of 
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female Lecturers in a department. 

“Male” or “Female” on 

forms 

First, consider whether you need to know the gender 

of each person completing the form, and remove the 

gender question if not. If you do need to include a 

gender question, e.g. for statistical purposes, it is 

advisable to include the further options “Non-binary” 

and “Prefer not to disclose”2 . 

Images Try to include diversity of gender in the images you 

use in webpages, posters, etc., and consider how 

you might overcome stereotyping - show a female 

scientist or a male homemaker, for example. 

Symbols (e.g. on toilet 

signs) 

A range of gender-neutral symbols are available and 

the Equality Office can advise on this. 

 

  

 
2 If you report on gender to another body, e.g. the HEA, check their requirements before 
altering your forms 
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7.0 Useful Resources and Links 

1. EU directive 2016/2012: Accessibility of the website and mobile applications 

of public sector bodies  

2. NALA, Plain English writing and Design tips, Retrieved from 

www.nala.ie/plain-english/plain-english-tips/   

3. Equal Status Acts 2000-2018 

4. Making a PowerPoint presentation to a more accessible 

form: https://youtu.be/kARiAZFgm2E 

5. Making a Word document to a more accessible 

form: https://youtu.be/YVzZQW6-s-8 

6. AHEAD Accessibility Series: AHEAD Webinar- Introduction to making a Word 

Document accessible 

7. AHEAD Association for Higher Education Access And Disability 

8. Penn State: Accessibility and Usability at Penn State 

form: Accessibility at Penn State | Charts & Accessibility (psu.edu) 

9. Diagram Center: Making Images Accessible - DIAGRAM Center 

10. Diagram Center: How to describe complex images for accessibility 

 

 

https://studentlit.sharepoint.com/Staff/Executive/President/Shared%20Documents/TU%20Application/AIT-LIT%20Application%20Document.pdf
file:///C:/SOT/LIT/Documents%20and%20Policies/New%20TU%20Docs/BM/Jan%2012th/Updated/a318.pdf%20(oireachtas.ie)
https://www.irishstatutebook.ie/eli/2000/act/8/enacted/en/html
https://www.irishstatutebook.ie/eli/2005/act/14/enacted/en/html
https://op.europa.eu/en/publication-detail/-/publication/ce26d769-b85d-11e6-9e3c-01aa75ed71a1
http://www.thea.ie/contentfiles/1A_v2.pdf
https://ahead.ie/creatingaccessibledocuments
https://www.youtube.com/watch?v=DfD6sqd858Q&list=PLoZ_XD6LkwMJOfw2MEjeExdjKQinHWm3q
https://www.youtube.com/watch?v=DfD6sqd858Q&list=PLoZ_XD6LkwMJOfw2MEjeExdjKQinHWm3q
https://www.nala.ie/plain-english/plain-english-tips/
https://www.cast.org/
https://op.europa.eu/en/publication-detail/-/publication/ce26d769-b85d-11e6-9e3c-01aa75ed71a1
https://op.europa.eu/en/publication-detail/-/publication/ce26d769-b85d-11e6-9e3c-01aa75ed71a1
http://www.nala.ie/plain-english/plain-english-tips/
http://www.irishstatutebook.ie/eli/2000/act/8/enacted/en/html
https://youtu.be/kARiAZFgm2E
https://youtu.be/YVzZQW6-s-8
https://www.youtube.com/watch?v=DfD6sqd858Q&list=PLoZ_XD6LkwMJOfw2MEjeExdjKQinHWm3q&index=3
https://ahead.ie/education
https://accessibility.psu.edu/images/charts/
https://accessibility.psu.edu/images/charts/
http://diagramcenter.org/making-images-accessible.html
https://www.youtube.com/watch?v=oSdz6KZpLjs
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7.0 Appendices 

Appendix 1: Accessibility Checker 

Appendix 2: MS Word Forms 
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Appendix 1: Accessibility Checker 

To access the Accessibility Checker in Microsoft Word select the Review tab from the 

application Ribbon (Fig.4) 

 

Figure 4 Review Tab in Microsoft Word 

Next select the Check Accessibility menu option (Fig.5) 

 

Figure 5 Accessibility Checker Menu Option 

 

The Accessibility Checker window (Fig 6.) will open on the right-hand side of the Word 

application. Any errors, warnings and suggestions for improving the accessibility of the 

document will be listed in this window. 

 

Figure 6 Accessibility Checker Report 
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Appendix 2: Microsoft Word Forms 

To enable the forms feature in Microsoft Word you need to customise the Ribbon in 

the Word application (Fig. 7). To do this, right click on the Ribbon bar and select the 

Customize the Ribbon option. 

  

 

Figure 7 Customise Ribbon in MS Word 

 

Select Developer from the menu options and then click the OK button. (Fig. 8) 

 

 

Figure 8 Microsoft Word Customise Ribbon Options 
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The Developer tab will now be available along the main Ribbon in the Word 

application (Fig. 9) 

 

 

Figure 9 Developer Tab in MS Word 

When you select this tab you can access the different questions for designing and 

building a form. The Developer tab allows you to insert a series of question types 

including: 

• Check box,  

• Combo box,  

• Drop down list  

• Date picker  

 

The Restrict Editing options ensure the document format and layout cannot be 

formatted by the end user. For additional support on learning how to use the Developer 

tab please watch the following video on creating Forms in Microsoft Word. 

 

 

 

https://www.youtube.com/watch?v=mRTQxVauzr0

